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From The Chief Editor's Desk
Phew! Has it ever been a busy past couple of months. I finally got my failing home central air conditioner replaced. I went ahead and replaced my home's furnace as well, at the same time. The AC unit was 21 years old (and failing miserably). The new furnace replaced my 18 year old furnace. The two together should save me considerable money in utility bills. Plus, they are a matched pair. Where I live, near Kansas City, it gets hot and humid in the summer (usually 80% relative humidity and higher, with temperatures 80-100° F), and it gets quite cold in the winter (typically with temperatures 20-40° F, but it's not uncommon for the temperatures to drop to as low as sub-zero° F when an arctic cold front moves through).
Meanwhile, my wife has been recovering at home after having surgery to have her gastric lap band removed, and having the gastric sleeve performed. I've taken about a week and a half off from work to stay home and help take care of the kids and helping tend to my wife's needs as she recovers. She's off work for six weeks total, and is already seeing some positive benefits of having the surgery.
I've been using some of the extra time off from work to also get some much needed work done around the house. I've performed some minor plumbing repairs, put new rain gutter guards on the rain gutters (and cleaned out the gutters, while I was at it), mowed the grass a couple of times, as well as cooking up some meals for me and the kids (since my wife can't start to eat anything solid for four weeks after the surgery). Of course, thrown into the mix is getting some work done for the magazine.

Also, around my area of the U.S., we've been dealing with some serious flooding. Many of the reservoirs are full, and the U.S. Army Corps of Engineers is looking to have to release some water downstream to preserve the integrity of the reservoirs. Of grave concern is the additional flooding downstream that it might cause. We have endured one of the wettest months of May on record. The streams and rivers are already running at flood stage levels, if not already over flood stage. In southeast Kansas, where Meemaw lives, the flooding is especially bad. The walking trail she typically uses for her evening walks is currently under six feet of flood water. At one point, she couldn't even get into the nearest town because the highway was under flood waters. Those waters have since receded, but it could happen again if we continue to get additional rainfall, or if the U.S. Army of Corps Engineers is forced to release more water from the reservoirs.
This Month's Cover
June 14 in the U.S. is celebrated as Flag Day. It's a day when Americans celebrate the adoption of the U.S. flag by the 1777 Continental Congress, the flag's history, and to show appreciation and pride for the flag. I thought why not expand it so that everyone, everywhere could celebrate their appreciation and pride in their flag. So, this month's cover includes the flags of 207 countries. According to worldatlas.com, there are 197 countries in the world (the U.N. only recognizes 195, refusing to recognize Taiwan and Kosovo), so I'm not exactly sure where the extra 10 countries come from. At first, I thought that they might have included the flags of countries that no longer exist, like the USSR and East Germany. But upon closer inspection, I discovered that those flags are not included. The image shows the flags of Palestine and the EU (which is a collection of sovereign countries), as well as other countries not formally recognized by a variety of agencies or governments. Of course, that left two blank spots in the image. I couldn't have that, so I added in one for PCLinuxOS, and another for Linux (consisting of Tux).
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ms_meme's Nook: Black Painted Desktop
PCLinuxOS Recipe Corner: Crispy Whole Chicken & Vegetables
Crispy Whole Chicken and Vegetables

Ingredients:
1 whole chicken (3 1/2 lb)
3 tablespoons olive oil
2 tablespoons Montreal chicken seasoning
1 1/2 lb baby (B-size) red potatoes, quartered
1 medium red onion, cut into wedges
1 tablespoon chopped fresh thyme leaves
3/4 teaspoon salt
1/4 teaspoon pepper
Directions:
1. Heat oven to 400F. Place chicken, breast side down, on cutting board. Using heavy-duty kitchen scissors or poultry shears, cut closely along one side of backbone from thigh end to neck. Repeat on other side. Remove backbone, and discard. Turn chicken over so breast side is up; press down to flatten breast area by pressing firmly with heel of hand. Rub chicken with 1 tablespoon of the oil.
2. Heat 12-inch cast-iron skillet over medium-high heat until hot; place chicken breast side down. Season side facing up with 1 tablespoon chicken seasoning; top with 10-inch heavy skillet to weigh down. Cook 5 to 7 minutes or until skin is golden brown. Remove smaller skillet, and transfer chicken to plate.
3. In medium bowl, toss potatoes, onion, remaining 2 tablespoons oil, the thyme, salt and pepper until mixed well. Arrange vegetable mixture in single layer in the 12-inch cast-iron skillet. Place chicken, breast side up, on vegetables, and sprinkle top with remaining 1 tablespoon chicken seasoning.
4. Roast uncovered 45 to 55 minutes or until juice of chicken is clear when thickest pieces are cut to bone (at least 165° F), and vegetables are tender and lightly browned. Garnish with additional thyme leaves, if desired.
Use caution when removing skillet from oven by using two heavy ovenproof mitts. The skillet (and handle) will be very hot.
Be sure to buy a chicken that's between 3 and 3 1/2 lb. Anything larger may not fit inside the skillet.
Expert Tips
Cast-iron skillets are great because of their heavy weight and their ability to retain heat. If you don't own two heavy skillets, try a weighted smaller skillet, or wrap bricks in foil, and use in place of a skillet.
Inkscape Tutorial: Create An Avatar
by Meemaw
An avatar is the graphical representation of someone, often used in social networks, forums, games etc. Usually, a 2D-avatar is a square image which has a small size (100x100px, 64x64px). I'm going to create an avatar for myself, and you can do the same. We'll start with simple objects like circles, ellipses, rectangles and squares.

Create a circle using the circle tool. Convert the circle to path using Path > Object to Path. Edit the path by the nodes to make it look like a human head.
Create an ellipse and edit its nodes, so that looks like an ear. Duplicate it (Ctrl+D) and flip it horizontally. Place both ears in the middle of the head.
To create the neck, draw a rectangle, convert it to a path and place two lower nodes closer to each other. An easy way is to select them and press Ctrl+< repeatedly.
Create shoulders with the rectangle tool and make the top nodes smoother. Make the shoulders narrower than normal to focus the viewer's attention on the head.
In our shape collection above, we see that one is darker than the rest... that is a duplicate I made of the neck. Using that duplicate along with the original, you can create a “separation” between the head and neck in the form of a shadow.

There are a couple of useful features in Inkscape that can help you create avatar easily:
View > Icon Preview will let you preview the page or selected objects as an icon in different resolutions (16x16px/24x24px/32x32px/48x48px and 128x128px). Here's what I get:

It shows the icons for several sizes on the right, and will show on the left what you get if you try to make your icon any bigger. It will show you how your creation looks in icon size, to help you determine how you want to proceed, as far as detail and how much to include. For example, you could zoom in and concentrate on the face and omit the shoulders. View > Duplicate Window will open a new window with the same document in which you are working. Editing the original document will duplicate the changes in the second one. However, you can make changes in both windows. This feature can be useful when working in Inkscape as a whole, not just for this project.
Next, work on the facial features..


Usually eyes have an almond shape and are at the same level with the top edges of the ears. Create an ellipse and edit the nodes to get it the shape you want. Create two circles for iris and pupil.
Draw an eyebrow with Bezier curve in “Triangle in” shape mode. Convert the object to path and smooth needed nodes.
Draw a lash line with Bezier curve in “Ellipse” shape mode. Separate lashes can be easily done with Bezier curve in “Triangle in” shape mode. You can arrange them the way you want and then group them.
Add details to the ears by using Bezier curve in “Ellipse” shape mode. Convert both objects to path and give them the desired shape, then group them. If there are a large number of unnecessary nodes, go to Path > Simplify or just press Ctrl+L after selecting the path.
Also, many head elements are symmetrical and we can make things much easier. Simply create only one eye, duplicate it (Ctrl+D) and flip horizontally.
You can also use your Bezier tool to shape some hair for yourself, and edit the nodes to shape it the way you want. I made a couple of shapes in blending colors, because the light gives everyone's hair different highlights (and I also have a big gray streak in the front). Stack them however they look correct. This will also give depth & some shading to your avatar.
Now apply them to your avatar in the places desired. Mine is pretty simplistic, but it might be close to what I look like. Note: I'm terrible with facial features! However, just because I made my avatar similar to myself doesn't mean you have to. You can make yours look like anything or anyone ... it's your creation!

In the tutorial I read, the next step was to add color, but I've been coloring everything as I went along. The next step here is to add some extra detail, like highlights where needed, and even jewelry if you want it. I added some eye shadow (I wear a kind of golden beige, so it really doesn't show all that much), highlights in my eyes and on my lips and hair, and edited the neckline of my shirt to add a necklace. It's easy! We've used this extension before. Create one bead with the Ellipse tool, then draw a necklace path with the Bezier tool. Use the Pattern along Path extension by clicking Extensions > Generate from Path > Pattern along Path. Make sure that you place the bead on top, otherwise the extension won't work correctly. To see the result before you apply, make sure you click Live Preview. You can make the highlights the same way. (Make earrings to match!)

You should get one object consisting of many beads along the path.
All that's left is some fine tuning, like shadows on the face. Add more details to the hair -- most of this can be done with lines using the Bezier tool. After that, add shadows under the eyes, a seam/opening on the shirt and pink highlights on the lips if you haven't already done it. How involved you want to get is entirely up to you. Now export your avatar! You can export an icon sized avatar as well. This one is 128 x 128.



De-Googling Yourself, Part 2
by Alessandro Ebersol (Agent Smith)

Google is a threat to the privacy and the very daily life of its users. Why? Because Google profiles its users. And, how did it all begin?
Profiling to better serve ... (?)
To get better search results, Google started profiling its users. And thanks to that, the search results have been improving over the years.
But Google needed a better way to capture users' personal information, to better work the search results. And, what better way than the users themselves giving their personal data to Google?
So, in 2004, Gmail was born. This was the beginning of the Google Office suite (G-suite), initially a service that only accepted users by invitation (in a period when it was labeled as a beta program). It was opened to the general public in 2009, five years later.
And so, Google began to profile the users of its search service through its email service. To get an idea of how profiling works, try searching Google when you're logged in your account, and then search the same terms when you're logged out of your account to see how the results look different.
How Gmail reads emails (and, time to freak out now)

Google's email servers automatically check email for a variety of purposes, including adding contextual ads alongside emails and spam and malware filtering. This is the official version of why your messages are read. But the innocent and noble causes can lead to much darker consequences.
Privacy advocates have raised many concerns about this practice. The concerns include that since email content is read by a machine (as opposed to a person), it may allow Google to keep unlimited amounts of information forever. Automated background scanning increases the risk that the expectation of privacy in the use of e-mail will be reduced or eroded. The information collected from emails can be retained by Google for years after its current relevance to create complete user profiles. Emails sent by users of other email providers are verified, although they have never agreed to Google's privacy policy or terms of service. Google may change its privacy policy unilaterally, and for minor changes to the policy, it may do so without informing users. In court cases, governments and organizations may find it easier to monitor e-mail communications legally. At any time, Google may change the company's current policies to allow the combination of e-mail information with data collected from the use of other services. And, any internal security issues on Google systems can expose many - or all -- of their users.
So much so that in January 2010, Google detected a "highly sophisticated" cyber attack on its infrastructure originating in China. The targets of the attack were Chinese human rights activists, but Google found that accounts owned by European, American and Chinese human rights activists in China were "routinely accessed by third parties." Thus, data collected by Google has been abused by third parties.
Google, on June 23, 2017, announced that by the end of 2017 it would phase out the scanning of email content to generate contextual advertising, relying on personal data collected through its other services. The company said that this amendment was intended to clarify its practices and lessen the concerns of G Suite business customers, who felt an ambiguous distinction between the free consumer and the paid professional variants, the latter being free of publicity.
However, the above highlight demonstrates that, rather than diminishing, Google's meddling has increased. This is because of all the products Google offers, and its ability to monitor the use of those services.
Google creates many tools that are useful to users and administrators, but they are designed to collect user data and create as much of a profile as possible, which is sold to advertisers, governments, other data brokers, or anyone else who wants to pay. The difference is that the method Google uses is aggregation.
I'll list some of Google's popular (and some even transparent to the end user) services and products that profile their users, and help the company catalog the online habits and actions of those who use them.
Google AMP (Accelerated Mobile Pages)

Google AMP is a service that stores data, usually media, on Google servers around the world. This means that when you upload a website with AMP enabled, the images and media come from Google's servers. This means that when you visit a website with AMP enabled, Google knows all the features you've loaded on the page. Interestingly, this gives Google access to substantially more information than your internet provider could get, because HTTPS encryption prevents the provider from seeing the specific pages you visit. They can only see the domain. For example, your ISP might see that you visited Reddit, but not what you visited on Reddit. The linked Google AMP content on Reddit (and there's a ton of it) gives Google a direct IP link, content that they can document and use to map user behavior and activity profiling.
This problem is widespread. WordPress sites, which are the most popular content management system in the world, have AMP enabled by default.
Worse, Google has recently announced that Chrome mobile users will not even know when they're using amp-served content. Chrome will hide the AMP content behind the original URL.
Google Analytics

Google Analytics uses cookies and cross-site tracking to identify and track users as they browse the Web in their daily routines. Google Analytics works by assigning a user a cookie with a unique ID number, and every time a user visits a site with Google Analytics enabled, Google records that activity and links it to the user with that particular cookie. Many times, this is done without the user being aware.
Recently, the European General Data Protection Regulation (GDPR) has created many warnings to users about this type of analytical software, but has been inefficient in restricting its use because Google Analytics is so ubiquitous that it bothers users with cookie warnings at almost all sites visited. Many do not follow GDPR's rules and allow users to browse the site or use services without tracking.
Google Cloud

Another great data point for Google is the Cloud. As of 2018, Google hosts about 9.5% of all cloud content in the Google Cloud (by revenue, most Google cloud services are "free" and they can host much more by volume). If you're using an application or website that uses the Google Cloud infrastructure, this is another gateway for your information. A user does not grant Google permission to retain data about them to use Google Cloud services.
Google Maps API

Every time you visit a company website and use Google Maps (not a screenshot), it uses the Google Maps API. This data is combined with Google Analytics to attach location information to your Google profile.
Google FireBase

FireBase is a tool that allows developers to easily synchronize data between different sites, applications and services. The caveat is that this data is synchronized through Google's servers, which record all this data and profile without the user's knowledge.
Google Chrome

Google Chrome records everything you've searched for on Google Search, all the websites you've visited or tagged, all the YouTube videos you've watched, all the ads you've clicked on, and how many passwords were automatically filled by Google Chrome.
These registered browser habits of Google Chrome include:
And, by the end of 2018, Google Chrome automatically logs you in when you access Google sites. That is, almost mandatorily, the user is forced to share his/her activity online with Google.
Android devices

We come to a very important point, and that is also perhaps the most vulnerable point of the user's relationship with Google, since the Android operating system, the Google application store(Google Play) and most (if not all) of the services of Google (GSF: Google Service Framework) are an inexhaustible source of enterprise intrusion into the personal lives of its users.
To download and use Google Play Store apps on an Android device, you must have (or create) a Google Account, which becomes an important gateway through which Google collects personal information including user name, email, and phone number. If an user signs up for services like Google Pay, Android will also collect credit card information, zip code and the user's date of birth. All of this information becomes part of an user's personal information associated with his/her Google Account.
In addition to personal data, Chrome and Android send information to Google about browsing activities and mobile apps, respectively. Any visit to a webpage is tracked and automatically collected under Google's user credentials. If you sign in to Chrome, the browser will also collect information about browsing history, passwords, site-specific permissions, cookies, download history, and additional user data.
Android sends periodic updates to Google's servers, including device type, mobile service provider name, crash reports, and information about apps installed on the phone. It also notifies Google whenever an application is accessed on the phone (for example, Google knows when an Android user accesses the Uber application).
The Android and Chrome platforms meticulously collect user location and motion information using a variety of sources, as shown in the figure below.

For example, a "rough location" rating can be done using GPS coordinates on an Android phone or via a laptop's network IP address. User location accuracy can be further improved ("good location") by using nearby cell tower IDs or by scanning device-specific BSSIDs or basic service set identifiers assigned to the radio chipset used in access points near WiFi hotspots. Android phones can also use information from registered Bluetooth beacons with the Google Proximity Beacon API. These beacons not only provide the geolocation coordinates of the user, but can also identify the exact floor levels in buildings.
It is difficult for an Android mobile user to "refuse" location tracking. For example, on an Android device, even if an user turns off WiFi, the location of the device will still be monitored through WiFi. To avoid this tracking, WiFi scanning must be explicitly disabled in a separate action as shown below:

The omnipresence of WiFi hubs has made location tracking quite frequent.
For example, in a study conducted by Professor Douglas C. Schmidt, of Vanderbilt University, during a short 15-minute walk around a residential neighborhood, an Android device sends location 50requests to Google. The request contained collectively about 100 unique BSSIDs from public and private WiFi access points.
Google can check with a high degree of confidence whether a user is standing, walking, running, cycling or riding a train or car. It achieves this by tracking the location coordinates of an Android mobile user at frequent time intervals in combination with panel sensor data (such as an accelerometer) on mobile phones.
But it does not stop there. Because of the infrastructure that Google services enable, there is a whole host of enterprise products that are used daily by advertisers and internet advertising companies.
Google products for online ads and advertisers

An important source for Google user activity data collection mechanisms are its publisher and advertiser tools such as Google Analytics, DoubleClick, AdSense, AdWords, and AdMob. These tools have a huge reach, for example. more than a million mobile apps use AdMob, over 1 million advertisers use Google AdWords, more than 15 million websites use Google AdSense, and more than 30 million websites use Google Analytics.
There are two main groups of users of the Google tools that are focused on publishers and advertisers:
Together, these tools collect information about user activity on websites and applications, such as visited content and clicked ads. They work in the background - largely imperceptible to users. The figure below shows some of these main tools, with arrows indicating data collected from users and ads displayed to users.

Conclusions
It's frightening how much intrusion Google has in our lives, whether we know it, or worse, without knowing anything. Without suspicion, we live in a birdcage, where advertisers, big corporations and governments know of all our steps, our tastes, our political and religious orientation.
Our secrets are no longer ours, but, they are with the corporations now: Google, Apple and Facebook know when a woman visits an abortion clinic, even if she does not tell anyone else. The GPS coordinates on the phone do not lie. Extramarital affairs are an easy thing to imagine: two smartphones that have never met before, cross into a bar and then head to an apartment across the city, stay together at night and leave in the morning ... well, you can imagine the rest.
It's a sad brave new world. But not everything is lost. It is possible to improve privacy and lead a more reserved life. We will see how, in the next article. So, stay with us, next month for more.
![]()




Gmail Eerily Tracks Your Purchases
by Paul Arnote (parnote)
Now just when or from where did you purchase those multi-colored shoe laces? If you purchased them online, or if you had a copy of your receipt emailed to your Gmail account, Google knows. And, Google remembers.
Unceremoniously and quite stealthily, Google has amassed a wealth of information about your purchasing history. Every item you've ever purchased online (and used your Gmail email address for purchase confirmation) and every time you've had a merchant you do business with email you a copy of your receipt to your Gmail email address, that information has been extracted and stored by Google. This shocking revelation came out in a May 17, 2019 article on CNBC.
Here's one scary part about all of this: your purchase history is likely to go back YEARS. My own purchase history goes all the way back to 2013. Some people, like Nick Statt on The Verge, have their purchase history go all the way back to 2010.

The small snippet shown in the screenshot above is from March, 2019 of my own purchase history that Google has saved. Until I ran across the CNBC article, I never even knew that Google was keeping track of my purchases. That tends to be the surprise reaction from most people.
So, let's take a look at what the information in the small snippet above shows, working from the bottom of the image to the top. Well, there is the Amazfit Bip Smartwatch I bought for my wife for her birthday. Then there is my annual subscription renewal to my MLB At Bat account. In the early part of March, I purchased a new small form factor laptop to replace my out-of-date and defunct netbook. I did purchase some popcorn popping oil for the popcorn popper we have at work from a restaurant supply company. Oh, and there is the ice cream cake from Baskin Robbins that I ordered and purchased online for my wife's birthday.
So how revealing is this information? Well, it shows that my wife most likely has a smartphone, since most smartwatches connect to smartphones. It shows that we are more than a little bit tech savvy. It shows that I happen to like baseball and popcorn. Oh, and it shows that we (my wife and me, at least) are chocoholics. And that would be just the tip of the iceberg. The information you can infer from all of this is massive.
Don't worry ... this gets better. Follow along here.

Go here, and you can view all of your payments and subscriptions that Google tracks. Just below the section where Google tracks your payment methods, you will find the "Purchases" section. Click on the "Manage purchases" link at the bottom of the box.

Notice how, at the top of the resulting screen, Google informs you that "only you can see your purchases." Yeah, right. Only me ... AND Google! So, I clicked on the first item in the list of purchases, which wasn't a purchase at all. It was a return. I returned some wrong size screen material to Home Depot that I had purchased in error. I just had the receipt sent to my Gmail account.

Clicking on the "purchase" brings up a window that displays all the sorted details of my transaction. Then, clicking on the "Remove Purchase" link at the bottom of the transaction results in the display of the new popup window. Seriously? To remove the purchase, I have to delete the email? This shouldn't be my only option. Maybe I need to save the receipt that is included in my email for future reference or warranty claims.
From the CNBC article:
"To help you easily view and keep track of your purchases, bookings and subscriptions in one place, we've created a private destination that can only be seen by you," a Google spokesperson told CNBC. "You can delete this information at any time. We don't use any information from your Gmail messages to serve you ads, and that includes the email receipts and confirmations shown on the Purchase page."
Except, there is no easy way of deleting your purchase history unless you delete the email containing the receipt for the transaction. Ok. Let's see if there's a way to do this from another angle. Let's go to Google's activity control page. Certainly, there must be some setting I can make there to prevent Google from tracking my purchases.
Nope. There is NOTHING there to manage whether Google tracks your purchases, either. This is the other scary aspect of Google tracking your purchases. There is NO WAY, short of deleting the email containing the information, to turn off purchase tracking or deleting information from your purchase history.
Google vehemently asserts that nothing in or from your Gmail account is used to target ads to you (don't forget that Google's primary source of income is from serving you ads). In fact, the contents of your Gmail account has not been used to serve you ads since they stopped the practice in 2017. They also claim to not sell your data to advertisers. So, what about other entities? Let your imagine roam on just who those "other entities" could or might be. You probably won't land too far away from the target bullseye.
So, if Google isn't using the information to target ads to serve up to you, then why are years of purchase information being stored? Most people don't even know that Google is doing this. Also, if Google isn't using this information, then what is the purpose of saving years of purchase information? And, why make it so hard to delete that information?
Google has said that it is looking into making the settings simpler and easier to control. Still, Google has obviously abandoned "Do No Evil" as a corporate motto. Instead, it seems more like the programming for V-Ger in Star Trek: The Motion Picture. Collect all data that can be collected.
Fortunately there may be one way to thwart Google's collection of your purchase history. The ONLY reason my purchase history only goes back to 2013 (despite having a Gmail account from back in the beta days in 2005 or before) is that I used to use an email program to download my emails from Gmail, and then delete them from Gmail after they were downloaded to my computer. That is the ONLY rational explanation I can conceive of for why my purchase history doesn't go back any further than 2013, while other users have purchase history going back even farther in time. Since at least 2013, I have exclusively used the Gmail webmail interface for all of my Gmail interactions.

Google's behavior reminds me of a popular internet meme. Obviously, no one at Google has ever heard of the maxim "just because you can, doesn't mean that you should." If they have, then the whole meaning of it has become lost on them.



The Ruby Programming Language:
Data Handling with Variables, Classes, Arrays and Strings
























Forgotten Wifi Passwords? Here's How To Find Them
by Paul Arnote (parnote)
PCLinuxOS, and Linux in general, is pretty good about remembering the passwords for our wifi connections. In fact, it may be too good. Usually, once we enter a valid password for a particular wifi connection, we rarely -- if ever -- have to enter it again. That ability to remember wifi connection passwords can also aid us in forgetting them, which can lead to some frustrating moments when it comes time to recall them.
Maybe you just forgot the password(s). And, who could blame you if you did? Or, maybe you want or need to share your wifi connection with guests, but can't remember the password. Hopefully, you're using complex passwords that can't easily be guessed, either. Plus, let's hope you're using WPA/PSK, and not WEP, for wifi security. WEP can typically be "broken" in less than 60 seconds by a determined and modestly intelligent hacker. While WPA/PSK is not immune from being hacked, doing so requires a LOT more work. A typical hacker will most likely move on to an easier target.
Fortunately, there are a couple of ways to "rediscover" your saved wifi connection passwords. Let's start by taking a look at the graphical way to recover them.

Open the PCLinuxOS Control Center. Click on the "Network Center" icon.

Now, click on the caret next to the connection you want to use. In this case, it should be your wifi connection. Select the wifi connection, and then click on the "Configure" button.

The fourth item down in the new window is labeled "Encryption key." Just beneath that, on the left side of the window is a checkbox labeled "Hide password."

Uncheck the checkbox, and the password for your selected wifi connection will be displayed. (My information is blocked from your view, for obvious reasons).
Of course, this being Linux, there is more than one way to "rediscover" your wifi connection passwords. Let's take a look at how to do it from the command line.
![]()
Of course, you can't access the information as a regular user, so you will have to issue the command as the root user.
As the root user, enter grep psk= /etc/wpa_supplicant.conf at the command line.

Displayed (and blocked out for your viewing pleasure) will be all of the wifi connection passwords you've used at the bottom of the output. The passwords are not listed with the particular network they are associated with, at least by using this command.

Using the command tail -n22 /etc/wpa_supplicant.conf (as the root user) will give me not only the wifi connection passwords stored on my computer, but also give me the SSID of the wifi network connection that each password is associated with. You may need to use a number larger than 22 (number of lines at the end of the file to display) if you have more wifi connections stored in wpa_supplicant.conf than the three that I have stored.
Now if you're thinking that there is an inherent security liability from storing the wifi connection passwords in unencrypted text files, you might be right if access was open to all who wished to view it. But, the information is only available to the root user. So, if anything, this illustrates that you need to be careful about who has access to the root account. Graphically or from the command line, the information is only accessible by the root user.
As far as I know, none of this information is useful to help you crack or hack a wifi connection password you do not already have access to or been granted access to. For that, there are other tools you can use or try, with variable success.



Short Topix: Google, Other Tech Giants Buying Up Internet Undersea Cables
by Paul Arnote [parnote]
IE: Yet Another Security Flaw

Yet another security flaw has been found in the "internet-browser-that-wouldn't-die-even-though-Microsoft-wishes-it-would," Internet Explorer. The last version of Internet Explorer was released in 2013, six years ago. Despite being replaced by Microsoft's newer browser, Edge, Microsoft still maintains multiple versions of Internet Explorer to support legacy applications. In fact, in the ensuing six years, even Edge has seen some significant changes, having been rebased just this year on Google's open source Chromium browser.
And this security flaw is a doozy. Users could be at risk just by having it installed. The security flaw comes from MHT files, which are IE's web archive format. Windows uses IE to open MHT files, by default. But you don't even have to open IE to be affected. If you download a MHT file sent through chat or email, hackers can spy on Windows users and even steal their local data. That data can include contacts, online transactions, and other private and personal data that users are typically lax about security on.
While Microsoft has said that it "will consider" a patch for the vulnerability in a future update, it isn't assured that one will be coming. Therefore, millions of Windows users are at risk until a patch is released, if it's even coming at all. So, the advice to Windows users is to either turn off Internet Explorer, or point to another program that can open MHT files. Of course, it might be wise to avoid downloading any MHT files, as well.
I don't know about you, but it's things like this that make me very glad to be a PCLinuxOS user!
Make Firefox More Efficient By Disabling Lazy Loading

By default, Mozilla's Firefox web browser has "lazy loading" turned on. Not sure what "lazy loading" is? Let's explain.
Let's say you have a number of "pinned" tabs that are loaded when Firefox starts up. Or, let's say that you have Firefox setup to remember your open tabs when it closes, so they can all be re-displayed when Firefox is relaunched. With "lazy loading" turned on, the content of each tab is not loaded until you click on each particular tab. This initially improves Firefox's loading time, and some users are just fine with this behavior. But, some users want to work more efficiently by having the content of all tabs already preloaded when it is needed, instead of waiting for each tab to load its content.
Fortunately, it's relatively easy to turn off "lazy loading." Open a new tab in Firefox, then type about:config into the address bar. Agree to "be careful" and accept the risk (if you're a long time Firefox user, you probably already know the routine), and then type browser.sessionstore.restore_on_demand on the search bar in the window that subsequently appears. The default value will be set to "true." Double click on the "true" setting to change it to "false." Close and then restart Firefox. Now, all of your tabs will load just as soon as Firefox loads, and you'll no longer have to wait for each of them to load when you click on each individual tab.
Google, Other Tech Giants Buying Up Internet Undersea Cables

I recently read an alarming article on VentureBeat that I had never really thought about before. There are over 700,000 miles (1,147,550 km) of submarine (undersea) cables in use today. Historically, those cables have been owned by groups of private companies, comprised mostly of telecom companies. But, 2016 saw a new group jump into the submarine cable arena: content providers.
Google leads the way, with the direct/whole ownership or part ownership of nearly 65,000 miles (106,560 km) of submarine fiber optic cable. That's enough submarine fiber optic cable to wrap around the Earth's equator 2.5 times, with a few thousand miles of cable to spare. This past February, Google announced plans to move forward with the Curie cable, a new 6,400 mile (10,476 km) submarine cable from Los Angeles, Calif. to Valparaiso, Chile.
Google isn't alone in its pursuit of ownership of submarine fiber optic cables, either. Other tech giants are also clamoring for their share of the pie. These companies include Amazon, Microsoft, Facebook, and others. You can view an interactive map from TeleGeography of all the major submarine fiber optic cables here. The interactive map will display the owner of each cable. Just click on the cable name in the sidebar on the right side of the map.
As mentioned earlier, historically these submarine cables have been owned by private telecom companies. Back when they were being installed, we didn't worry about privacy concerns. We trusted those companies, rightfully or wrongly. But now, these tech giants are buying up the literal backbone of the internet. Given their utter disregard for users' privacy and their cavalier attitude towards users' private information, well ... therein lies the concern that leads to the sense of alarm.
As the owners or partial owners of these information conduits, carrying massive amounts of data, what's to prevent them from siphoning off even more of our private information that they already don't possess or respect? These tech giants have done exceptionally little to earn our trust over the years, and have behaved especially poor in recent years. Then, there's the rumors and speculation of just how much the tech giants are "in bed" with the three and four letter government spy agencies.
Without a doubt, the submarine fiber optic cables are necessary not only for growth of the internet, but also for shaping the internet of tomorrow and beyond. I'm just not sure that the giant tech companies are the best caretakers/custodians of these information conduits. While I realize that this may sound like rank paranoia, or that it may make me seem like a conspiracy theorist, given their track record, they haven't given any of us enough reason to trust them with our privacy and private data. In fact, given their recent "performances" in this area, they have provided ample cause for doubt and suspicion. So not only are they sucking up our private data faster than a Hoover vacuum cleaner on steroids, they are now going to OWN the means of getting that data from point A to point B. Users would be negligent to not be concerned.
G7 Countries Negotiate Tech Regulation Charter

You've heard of the G7 (Group of 7) countries, right? The group is made up of the United States, United Kingdom, Japan, Canada, France, Germany and Italy. The EU also has a representative. Started back in 1975, these countries have the seven largest advanced economies in the world. Together, they represent 58% of the global net wealth, and more than 46% of the global gross domestic product (GDP). The G7 meets at least annually to discuss economic policies.
So, according to an article on TechCrunch, the digital ministers/leaders of the G7 countries met on May 15, 2019 to discuss an upcoming charter on toxic content and tech regulation at large. The plan is for the G7 member nations to sign the charter at the upcoming G7 Summit in August, to be held in Biarritz, France. Additionally, officials from Australia, India and New Zealand participated in the meeting.
From the article:
"Everyone has to deal with hateful content," France Digital Minister Cédric O said in a meeting with a few journalists. "This industry needs to reach maturity and, in order to do that, we need to rethink the accountability of those companies and the role of governments."
One of the problems to overcome is how some countries want protections for free speech, while others are pushing for more regulation. "Hateful speech" won't be precisely defined, but a set of guidelines/principles to follow should help countries makes laws to address this issue.
We'll have to wait until August to see how all of this plays out.
Ransomware Holds City Of Baltimore Hostage

The city of Baltimore, Maryland had to take several of its systems offline on May 7, 2019, after their computer systems were victimized by a nasty ransomware virus, according to an article on ArsTechnica. More than two weeks later (at the time this article was written in late May), Baltimore's systems remain offline.
The ransomware attack by the aggressive RobbinHood ransomware is similar to another attack in April that hit Greenville, North Carolina. The FBI, who is helping investigate the ransomware attack, have identified the ransomware as a new variant of the RobbinHood ransomware that has emerged within the past month.
In the past, the RobbinHood ransomware has not been able to be spread across a network. Rather, the software typically has to be installed on each infected computer by a user with administrative access to that computer. It is spread to individual machines via a psexec system internal call, and/or by compromising the domain controller. Additionally, RobbinHood requires that a public RSA key already be present on the target computers in order to begin encryption of the computer's files. Thus, the attacker would have had to deploy the ransomware in a series of multiple steps.
Here's an excerpt from the ArsTechnica article that illustrates just how nasty this ransomware is:
Before it begins encryption, RobbinHood malware shuts down all connections to shared network directories with a net use * /DELETE /Y command and then runs through 181 Windows service shutdown commands--including the disabling of multiple malware-protection tools, backup agents, and email, database, and Internet Information Server (IIS) administrative services. That string of commands--which starts with an attempt to shut down Kaspersky's AVP agent--would create a lot of noise on any management system monitoring Windows systems' event logs.
This isn't the first go-around for Baltimore in dealing with a ransomware attack. In March, 2018, the city's 911 system was attacked by ransomware when the city's IT department was doing some maintenance work on the city's firewall. That work briefly left a few holes in the city's firewall, which attackers found and exploited, probably by an automated scan. The firewall holes (and maintenance) were only present for about four hours before the ransomware attacked the system.
It's stories like this that make you scratch your head and wonder what IT departments and CIOs are thinking by putting the operating system with the WORST security ever in charge of mission critical systems. It's stories like this that make me glad to be a Linux user.



PCLinuxOS Family Member Spotlight: BillDjr
as told to YouCanToo
What is your name/username?
Bill Dawson Jr. (BillDjr)
How old are you?
Feels like 1,000. I'm 56.
Are you married, single?
I've been very happily married for 20 years. My wife is a saint.
How about Kids, Grandkids (names and ages)?
I have 2 kids. Liam, age 15 and Chorin, age 10. Best kids ever.
Do you have pets, what is your favorite?
We have a dog named Buddy. He has a supernatural gift to piss me off.
Are you retired, still working and if working, what do you do?
I'm on a disability income. Always on the hunt for things to do.
Where do you call home? What is it like? IE: weather, scenery
Ottawa, Ontario, Canada. Yes, winters are brutal. We all live in igloos. Summers are equally brutal. Way too hot and way too humid. We are blessed with plenty of greenery everywhere we go.

Parliament Hill, Ottawa

Embassy Tower of Taiwan, Ottawa

The Maman Statue
Where did you go to school and what is your education level?
I went to Merivale High School in Ottawa, but missed graduating by 3 credits. I got my real education at the school of hard knocks.
What kind of things you like doing? hobbies, travel, fishing, camping?
It frustrates the hell outta me sometimes and hurts my brain, but I really enjoy programming. Can't wait until I have enough experience with python to start using that full time instead of the IDE for BASIC I've been using.
I am totally fascinated by quantum mechanics. The implications on the nature of reality are earth-shattering. I'm also one of those "red pill" people, if you know what that is … always going down many rabbit holes at the same time. That, too, can be earth-shattering.
I've only ever traveled once, to Cozumel with my wife. We absolutely adored the place. Sadly, finances have always been an issue for us, so more traveling doesn't seem to be in the cards.
I'm an ex-wanna-be rock star, and recently my son Liam has begun putting together techno and dubstep music tracks on his laptop. That boy's got some real talent. We have started having lengthy discussions about the nuances of music and his tracks in particular, which gets us both really fired up. He woke up the musician in me, which I am so grateful for.
My favorite hobby of all is threatening to tickle Chorin. I don't actually have to do it, just threaten, and he goes off as if I had done it. Cracks me up every time.
Why and when did you start using Linux?
I was introduced to Linux about 20 years ago, as a means to set up a web server. Redhat 5. I took to it like a fish to water, and did run it as a server for many years, but never considered it as a desktop system due to my being quite the gamer at the time … until 2007, when I discovered PCLinuxOS. I've kept up with PCLinuxOS and other distros over the years, but was never ready to "take the plunge". I was very adept at Windows and all its deep inner-workings, and the thought of switching to something else where I'd basically be back to square one seemed pointless. Then along came Windows 10. That did it. I was ready to switch, and thankfully, I did. I can honestly say that I don't miss Windows one bit. It never even enters my mind. While the first month with PCLinuxOS was a major struggle, that came down to using Mate. Nothing against Mate, it just didn't seem to agree with my system somehow. Switching to KDE solved pretty much all of my problems.
What specific equipment do currently use with PCLinuxOS?
Toshiba Tecra R950 Laptop
Intel i7-3540M 3.0 ghz
AMD Radeon 7500M/7600M HD Graphics 1 gb RAM
16 GB RAM
Realtek HD Audio
500gb SSD
PCLOS KDE 5 Plasma 2019
Laptop screen: 15" 1366x768
External Monitor: 24" BENQ G2450HM 1920x1080
Do you feel that your use of Linux influences the reactions you receive from your computer peers or family? If so, how?
Absolutely. With the single exception of my wife, they all fall prey to the stigma that Linux is for geeks and gurus. They're basically afraid of it and too comfortable with Windows, in spite of its many issues. Short of taking my laptop everywhere and making people sit down and give PCLinuxOS a try (it worked with my wife!), there's just no convincing them.
What would you like to see happen within PCLinuxOS that would make it a better place. What are your feelings?
I don't feel that PCLinuxOS is lacking at all, nor needs anything to make it "better" (and DAMN, it boots up fast!). Obviously, Tex et al do an awesome job with this OS and I really can't ask for more. My laptop has never run faster or been more stable. As for the folks on the forum, I have a few things to say: First, it's so refreshing to visit a forum where there's a noticeable lack of in-fighting, power-struggles, and abuse. You're all grown-ups and you act like it. Everyone is so friendly and willing to share their time and knowledge on an ongoing basis. There's a palpable comradery here. I have the utmost respect for everyone on the forums, and I am very grateful for all your help and patience. And last, but certainly not least, you all put up with my special brand of crazy BS!
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by YouCanToo, featuring PCLinuxOS forum member. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to youcantoo, parnote or Meemaw in the PCLinuxOS forum expressing your interest.

PCLinuxOS Bonus Recipe Corner: 5-Ingredient InstaPot™ Barbecue Pork Ribs
5-Ingredient Instant Pot™ Barbecue Pork Ribs
Ingredients
1 cup chicken broth
1 tablespoon barbecue seasoning
1 tablespoon Worcestershire sauce
3 lb baby back pork ribs, cleaned and cut in 4 (3- to 4-rib) sections
1/2 cup sweet & spicy BBQ sauce
Directions
1. Spray 6-quart Instant Pot™ insert with cooking spray. Mix broth, seasoning and Worcestershire sauce in insert. Add ribs; turn to coat. Stand ribs up against sides of insert.
2. Secure lid; set pressure valve to SEALING. Select MANUAL; cook on high pressure 15 minutes. Select CANCEL. Keep pressure valve in SEALING position to release pressure naturally. Transfer ribs to cutting board; cool slightly. Discard cooking liquid. When cool enough to handle, cut sections into individual ribs.
3. Position oven rack 4 inches from broiler element. Set oven control to broil. Line rimmed sheet pan with foil. Spray with cooking spray. Place ribs on foil; brush all over with BBQ sauce.
4. Broil ribs 2 to 4 minutes or until sticky, crispy and blackened in spots.
Expert Tips
No broiler? Yes sir. No problem. While broiling adds nice flavor and color, the ribs will still be delicious if you need to skip that step.
Don't substitute larger ribs for the baby back ribs. This recipe was designed for the smaller racks, and larger ribs will not get tender in the same amount of time.
ms_meme's Nook: PCLOS Flyer
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